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1. Welcome

Welcome to your new software for the DotPad320 and DotPad320X.

In many countries, including Germany, Microsoft Windows is the leading operating system. 

Therefore, we are developing software that makes using the DotPad (320/X) easier on Windows 

PCs or laptops, even without a screen reader. You can download this software from the website.

2. Installing DotPad X Win

First, download the installation package "Setup-DotPadX-Win.exe" from the product page 

"https://dotpad.vision/produkte/dotpad/dotpad_x_windows/". Running this file will copy the 

software to the program directory and create shortcuts in the Start menu and on the desktop.

The files temporarily created during installation are automatically removed when the installation is 

complete.

You can now start the program via the Start menu or the desktop.

3. Starting the application

Click the DotPad X icon on your desktop:

Alternatively, select "DotPadX Win" from the Start menu 

and press Enter. The program does not require any special 

permissions or path information.

4. First steps

Depending on your settings, the program may take a few seconds to start. A simple startup graphic 

will inform you about the startup process. Once this graphic disappears, you can begin working 

with the program.

First, in the "Settings" menu, select your preferred 

language under the "Language" submenu. Then, go to 

the "Device" menu and select the serial port to which 

you connected the DotPad under the "Port" submenu. 

The software will then attempt to establish a 

connection between the PC and the DotPad. Of course, the DotPad must be switched on for this to 

work, even though the interfaces are displayed even when the DotPad is switched off.
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Attention: This version of the program does not yet support Bluetooth LE connections!

5. Connect DotPad

Connect the DotPad to your PC using a USB-A to USB-C cable. You should receive a message 

from your PC about newly connected hardware. In Windows Device Manager -, you will find two 

new ports (COM & LPT). Note the first number of these (e.g., COM10). In the 

DotPadX Win program, select -"Port" from the "Device" menu and choose the 

DotPad's COM port. A connection will now be established. The icon, which is 

currently a crossed-out link symbol, will change to a link symbol.

If the connection fails, the crossed-out symbol will remain. You can also click this 

symbol with your mouse to start or disconnect the connection process.

If the connection is successfully established, a simple graphic is displayed on the 

DotPad. This disappears the first time a custom graphic is displayed. 

Simultaneously, the product name, version, and interface are displayed in the 

information area on the right. You can also access this information 

in the "Device" menu under "Information" ( hotkey: Alt+I ).

You can enable automatic connection after program startup in the 

"Device" menu. Then the DotPad will connect automatically every 

time the program starts, as long as the COM port doesn't change.

6. Drawing
You have 10 tools available for drawing. These can 

be modified using the symbols Left  (Shift + Up Arrow) or Right  (Shift + Down Arrow).

The following elements are available:

 Paint brush

 line

 triangle

 square

 rhombus

 hexagon
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 octagon

 Circle

 eraser

 filler

It should be noted that due to the DotPad's low resolution, the shapes are not perfect. However, they 

can be easily felt on the DotPad itself.

If you have made a mistake, you can undo the last changes using the icon 

, the keyboard shortcut Ctrl+Z , or via the "Edit" – "Undo" menu. The individual layers are 

displayed in different colors. To apply the drawing, select "Apply" from the "Edit" menu, press 

Ctrl+Enter , or use the icon.

You can invert the current drawing via the "Edit" menu or using the keyboard shortcut Ctrl+I .

7. Braille (Blind Writing)

7.1. Select Braille language and level
To select the desired Braille language and level of 

translation, use the two list boxes to the right of the 

text fields. Use the Tab -key to move between the 

fields and then the arrow keys to make your 

selection. You can also use the mouse to make your 

selection. Please note that loading the tables may 

take a moment to complete the selection process.

Attention! When you are in the program menu, the 

selection buttons are replaced by an M to indicate that no selection is possible in this case.

7.2. Text input
As soon as you enter text into the input field, it is automatically converted to Braille and displayed 

in the 20-character range of the DotPad and the screen display. The conversion is performed 

according to the language and grade selection. If you change these, the text will also be displayed 

differently.



DotPad X Windows

5

7.3. Transfer the text to the graphics area
To drag the displayed text into the graphics area, simply left-click in the Braille text box. You can 

then drag the entire area into the graphics space and secure it by clicking the left mouse button 

again. Pressing Esc or right-clicking will cancel the action.

7.4. Displaying letters and text in large 
format
To display letters very large in both print and Braille, select the 

lower selection button and then use Ctrl + left/right arrow keys to 

navigate through the text. Only one letter at a time will be 

displayed in both text and Braille. You can select the corresponding 

font in the "Settings" menu under "Braille Font" or "Text Font." 

The Braille fonts are installed by the program, while the text fonts 

are system fonts from Windows.

Pressing Alt + left/right arrow displays multiple letters, albeit 

smaller. The same applies to the fonts used as to the display of 

individual letters. In the Braille display, you'll notice that the shapes 

aren't perfect circles; this is due to the mapping of the TrueType 

fonts to the low resolution. However, the shapes are easily 

discernible by touch.

8. Camera
DotPad X Win supports the connection of cameras, mostly webcams, to the DotPad via the so-

called "Still Capture API". The captured image is displayed in a small or large preview window, and 

a configurable portion of it is sent to the DotPad after prior processing. Numerous settings are 

available for this process.

You have to experiment a bit to find the best possible display.
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8.1. Setting up the camera
In the "Camera" menu, you can select one of the connected cameras from the "Device" submenu. If 

no camera is detected by the system, this menu will be inaccessible. If multiple cameras are 

connected, you will find them in the "Device" menu.

Next, select a suitable resolution from the "Resolution" submenu. Do not select a resolution that is 

too high, as it cannot be evaluated.

You can now activate the camera via the camera icon or the "On/Off" menu item. The program 

window will then expand to the right and a preview image will appear. Below this are 

several sliders for adjusting the camera properties. Properties that are not available 

will be grayed out.

8.2. The trigger / threshold
The individual color pixels of the camera (red, green, blue) are converted into grayscale values g = 

√(R² + G² + B²) to ultimately obtain a black and white value for display. This trigger or threshold 

can be set manually using a slider, or you can have it calculated dynamically. With the dynamic 

threshold, an average value is calculated across the sampled range. You can try both options and 

decide which value is better suited to your application.

8.3. The display area
When the program starts, the display area is the same as the DotPad resolution of 60x40 pixels. A 

semi-transparent area represents the display area. You can resize this area using the mouse wheel, a 

context menu (right-click), or the keyboard shortcut "Ctrl+Numpad+" or "Ctrl+Numpad-". Move 

the mouse over the camera image or the program window itself. To freeze the image, you can use 

the context menu or the "Numpad" key. This also allows you to use the mouse to access other menu 

functions.

9. Explore the screen
A similar workflow to using the camera is possible with "Explore Screen". To activate this function, 

press the key combination "Ctrl+Shift+Numpad-". The program window will disappear and the rest 

of the screen will reappear. Now you can drag the mouse across the screen and explore it on the 

DotPad.
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10. Program menu

10.1. File
The File menu has the following entries:

Open F3

N new Alt+N

Save F2

Save using Alt + F2

-----------------------------

End Alt + F4

Currently, 3 formats are supported for loading and saving.

 .DTM 

The standard DotPad format

 .BMP 

bitmap file, in black and white encoding, has a size of 60 x 44 pixels. It can be saved and 

loaded. Other encodings and formats will be included in a future program version.

 .XML 

We are still working on this format; in particular, a designated description area is still 

missing for adding a description to a graphic.

If you edit a file but don't save it, you will be asked at several points in the program whether you 

want to save the data. One of these points is closing the program.

10.2 . Edit
The Edit menu has the following entries:

Delete all Alt+D

Undo Ctrl+Z

Apply Ctrl+Enter

Invert Ctrl+I

-------------------------------------

Explore screen Ctrl+Shift -
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Some of these entries do not have buttons; they are rarely needed and can also be accessed via 

hotkey.

10.3. Device
Under Device, meaning the DotPad, you will find the following entries:

Connect

Port >

Information Alt+I

Connect automatically

These menu items were already described under point 5.

10.4. Settings
The following settings are possible:

Language >

Sound

Braille Font >

Text Font >

Under "Language" you can select the program language. Currently, German and English are 

available. Localization for other languages is easily possible and is described in a separate section.

The "Sound" button turns the playback of sounds within the program on or off.

For large display of text and Braille, see section 7.4, select the appropriate fonts here.

10.5. Camera
Most of these menu items were already explained in point 8:

On off

Device >

resolution

----------------------------------

small / large window Shift *

To turn the camera on or off, use either the menu item or the camera icon. 

Explanations about the camera can be found in menu item 8.
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10.6. Help
Help F1

-----------------------------

Via Alt+A

Info Alt+I

-----------------------------

www.DotPad.Vision Alt+W

Check for updates Alt+U

Pressing F1 will bring up this help. The other menu items are self-explanatory.
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11. Keyboard shortcuts
NUM+Shift+Ctrl Screen rounding on/off

ESC+Shift End program

F1 Go to help

F2 save file

F2+Alt Save as

F3 Open file

O+Alt Open file

N+Alt New file

I+Alt Show information window

A+Alt about this program

W+Alt Visit the dotpad.vision website

ESC Cancel

input Confirm

Z+Ctrl Undo

Enter+Ctrl Take over

Left+Ctrl Letters in large Braille

Right+Ctrl ... Letters in large Braille

Left+Alt Word in large Braille

Right+Alt Word in large Braille

High Braille language / grade selection

Down Braille language / grade selection

I+Ctrl Invert

tab Switch between Braille language, grade, and display

Tab+Shift Switch between Braille language, grade, and display

Num+ Increase threshold

Number- Reduce threshold

Num+Ctrl Increase display area

Num Lock+Ctrl Reduce display area

Num Lock+Shift still free

Num Lock + Shift still free

Num++Alt still free

Num Lock and Alt still free

Number* Freeze camera image

Number/ Manual threshold /

Enter+Shift Open popup menu

D+Ctrl Delete graphic area

+Shift

Up+Shift Switch drawing tool

Down+Shift Switch drawing tool
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12. Localization
To perform localization into another language, the following steps are required:

1. Locate the file “DotPadX.ini” in the \res directory and open it with a text editor, e.g. Edit, 

Wordpad…

2. In this file, locate the [ Language ] section, which is currently located from line 142 and 

looks like this:

[Language] 

01=de 

02=en

3. Create another entry, e.g. 03=cz

[Language] 

01=de 

02=en 

03=cz

4. Save this file and close it.

5. Open one of the files DotPadX_de.ini (German) or DotPadX_en.ini (English) in the editor 

and save it under the name DotPadX_cz.ini.

6. Now you can edit and translate this file line by line. 

In longer strings, "\n" means a line break and "\t" means a tab. A string, such as a name, is 

inserted into the sequence "%s" and a digit into "%d".

7. Save the new .ini file and start the program. You should now find your new language in the 

settings menu under Language.
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